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Getting Started

What is WinTalk?
WinTalk allows Windows users who have the WINSOCK DLL installed on their system to participate in 
real-time conversations with remote users, using the popular Unix “ntalk” and “talk” protocols.    The 
program acts as both a talk client and server, responding to remote talk requests with a pop-up “ring” 
dialog, an auditory ring, or both.

How do I use it?

Windows 3.1 / Windows NT:
Once you start WinTalk, the smiley-face icon will appear at the bottom of your screen.    To access 
WinTalk functions, click once on the icon with the left mouse button to bring up the system menu.

Windows 95 (taskbar option)
Without the icon tray option, WinTalk will start up as a taskbar pane (just like any other minimized 
application.    You will not be able to expand the pane into a main window, because WinTalk has no 
“main window” - all the functions are accessed through the system menu of the taskbar pane, which you
access by right clicking on it.

Windows 95 (icon tray option)
If you’ve chosen the icon tray option, WinTalk will appear only as a small icon in the ‘tray’ area of your 
taskbar.    Clicking on the icon will bring up the WinTalk main menu.

The Freeware Version
This version of WinTalk is provided as FreeWare, and thus you may freely distribute it providing 1) the 
distribution is *not* for profit, and 2) all files are included and unchanged (including this help file).    ELF 
Communications takes no responsibility for the results of using or misusing this software.    You can click 
to see the full text of the disclaimer under which WinTalk is distributed.    You may also be interested in 
WinTalk Pro, the professional version, which offers some added functionality and other benefits.

Feedback to ELF
If you have comments or questions, please do send email to “wintalk@elf.com”.    I'm working hard 
on other projects, so don't be surprised if replies take a while.



Windows does not inherently support any concept of login or user names.    Since TALK was originally 
written for Unix systems, it requires that you identify users by both a name and an IP address 
(hostname).    This has two repercussions - first, you need to supply a “from” name every time you talk 
someone remotely, so that their (potentially Unix-based) talk client can get back to you correctly.    
Second, other people must talk to you by using an address of the form user@hostname.

WinTalk deals with these issues by allowing you to configure a set of local usernames.    These names 
will be available for selection as from names in the talk dialog, and they may also be used to filter 
incoming talk requests, responding with “that user is not logged in” for usernames that don't match any 
of yours (see general configuration, under “Process requests for”).



Internet Resources for WinTalk Users

The Web Page
ELF maintains a WinTalk web page, which you can access by pointing your web browser at 
“http://www.elf.com/elf/wintalk.html”

The Mailing Lists
There are also two mailing lists for WinTalk users:

WINTALK-ANNOUNCE allows you to receive information about bug fixes, new releases, and any other
major WinTalk news.    This is a “read only” mailing list.

WINTALK-USERS is for open discussion about any WinTalk-related issues.

To join either list, send email to “majordomo@elf.com”, containing the text “subscribe 
<listname> <your email address>“.    For instance, you might write “subscribe WINTALK-
ANNOUNCE joe-user@aol.com”.    You will then receive a welcome message to the list, including 
information on policies and unsubscribing.



About ELF Communications

Founded in 1992, ELF Communications is a small, employee-owned company dedicated to 
bringing the finest new networking software to people who use the Internet.    Our products are designed 
to be open, easy to use, and powerful without being too expensive for personal use.    Through our 
software and activities, we strive to help the Internet be a medium for honest communication and a 
source for increasing world freedom and community.

To find out more up-to-date information about ELF and our projects, you can point your favorite 
WWW browser at “http://www.elf.com/elf/home.html”.

The next product I am working on is ERIS, a commercial multi-user conferencing system for 
Microsoft Windows(tm), based upon a “virtual conference room” paradigm.    If you'd like to find out more
about this product when it's closer to release, send mail to “eris-info-request@elf.com” 
containing the text “subscribe <your email address>“.

Enjoy!
--Gub (Glen Daniels, ELF Communications)



WinTalk Frequently Asked Questions

The latest version of the WinTalk FAQ file is available via FTP or the web:

FTP to FTP.ELF.COM, and get /pub/wintalk/wintalk-faq.txt.
or

Point your WWW browser at http://www.elf.com/elf/wintalk/wintalk-faq.html.

Please read the FAQ before emailing - most problems with WinTalk are covered, and we try to keep it 
up-to-date.

If you're still having trouble, and your problem is not covered in the FAQ, send email to 
wintalk@elf.com with a complete description of the problem (what isn't working, what exactly you 
did to get the problem to occur, the full text of any error boxes including error codes, etc.), and don't 
forget to include:

1. Which winsock / network stack you're using (winsock info is available in the WinTalk about box)
2. Windows version #
3. WinTalk version # (available in the WinTalk about box)

Please keep in mind that the Freeware version of WinTalk is not an officially supported product; although
we try to answer mail eventually, other projects take higher priority.    The FAQ or the WINTALK-USERS 
mailing list might also be able to help.



Handling incoming talk requests

When WinTalk is running, it continually listens for incoming requests to talk from remote users.    
You can place WinTalk in a variety of answer modes which will handle these requests differently 
depending on your desires.

The default behavior when someone tries to talk to you is to pop up a dialog and play a “ring” 
sound to announce the call.    (See general configuration for information on how you can filter incoming 
talks and control the announcement style.)

Answering via the   “  ring  ”   dialog  
Answering via the   “  Answer  ”   command  



Initiating a talk session

1. Select “Talk...” from the WinTalk icon menu.
2. The talk dialog will appear:

3. Fill in the “To”    field with the address of the person with whom you wish to talk.    For instance, the 
talk above is to a user “Fred” at the host “yoyodyne.com”.    The “To” listbox is initialized with the 
addresses on your hotlist, for easy access to people you frequently talk with.

4. Select a “From” name.    The “From” listbox is initialized with your local usernames.
5. (optional) Enter a TTY argument, to specifiy a particular terminal on a multi-user host.
6. Click the “Talk” button to initiate the call.    This will take you to the talk window.



General Configuration

The general configuration dialog looks like this:

Each section is described below.

Announce with:
WinTalk can let you know about incoming calls with a sound, a pop-up dialog, or both.    To select 
either option, check the appropriate box.
Sound options:
If you have a .wav compatible sound driver, you may select any .wav file as WinTalk's “ring” noise by
clicking the “Choose...” button, and test the sound by clicking “Play”.    Alternately, you may select 
“<system beep>“ from the sound listbox for a standard PC speaker beep.
Dialog options: 
You may choose a system-modal dialog (which will prevent you from accessing any other Windows 
application until the dialog has been dismissed), or a standard one.

Process requests for:
Controls who WinTalk considers “logged on” to your PC.    If you select “Local users only”, WinTalk 
will only handle incoming requests for users that are in your list of local usernames (talks for other 
users will return “not logged on” to the initiator).    “Anyone” will cause WinTalk to handle all 
requests. 

Default auto-wrap
Allows you to configure auto-wrap, a remote wrap size for long lines.    

Result on disable
When WinTalk is disabled, anyone who tries to talk you will see this message, either “User is 
refusing messages” or “User is not logged in”.



Default answer mode
Each time you start WinTalk, it will come up in this answer mode.

Ring timeout
If an unanswered call has been ringing for this number of seconds, WinTalk will automatically 
respond with a refusal or a “not logged in” message.    If set to 0, this feature is disabled.



Answering Modes

The “Answering Modes” menu (accessible from the WinTalk icon) allows you to control how WinTalk will
react to incoming talk requests.    The two modes are described below, along with the icon for each:

In enabled mode, WinTalk will announce appropriate talk requests with some combination of a ring sound
and a pop-up dialog (see general configuration, “Announce With...”).

In disabled mode, WinTalk will automatically refuse all incoming talks.    You can configure a particular 
response which the foreign user will see, either “Your party is not logged on” or “Your party is refusing 
messages” (see general configuration, “Result on disable”).



Hostnames and Addresses

IP addresses and hostnames:
Any host on a TCP/IP network is identified by 32-bit number called an IP Address, which is often written 
as four numbers separated by periods : for instance, “192.48.232.17”.    This number is very useful when
machines need to talk to each other, but not so nice for humans to deal with.    This is where the DNS 
comes in.    The DNS is a network directory service, translating names such as “frobozz.elf.com” into IP 
addresses.

Many winsock applications can get by just using your machine's IP address, but due to the particulars of 
the TALK protocol as implemented on most Unix systems, this is not the case with WinTalk.    Hence, you
need to have a couple of things configured correctly before you can use WinTalk.

WinTalk might need your hostname:
First, your machine might need to know its hostname for WinTalk to successfully start.    Please refer to 
the documentation included with your networking stack (Trumpet, PC/TCP, NetManage, PC-NFS, etc...) 
to find out how to make sure your hostname is configured correctly.    If you do not have a hostname 
configured, WinTalk may fail to start up in some cases.

Your hostname can live on your local machine (in your network stack's configuration), and it can (and 
should) also live on a DNS server.    Your local DNS server will be queried for your name when you try to 
talk to someone on a unix machine - so if your PC is not registered on an appropriate DNS server, you 
will not be able to talk to anyone running Unix talk!!    If you try, you will see the “Target machine does not
recognize us” message in the status bar of the talk window.    Also, some implementations of the 
winsock DLL (Trumpet, for example) will query the DNS server for your IP address when WinTalk starts 
up.

To register your machine in the DNS, you need to talk to your system administrator.    The specifics vary 
from machine to machine.

Variable IP-address systems:
In some cases, winsock users will be connecting to the internet via a SLIP connection which gives them 
a variable IP address; it can change every time they call their host systems.    In these cases, you'll be 
fine if every possible address is associated with a name.    If this is not the case, and for some reason 
your sysadmin does not want things set up that way, you're out of luck...

If you're having gethostname() or gethostname() problems...
Please make sure you're correctly registered in the DNS, then check the troubleshooting guide.



Addresses in talk are of the form '<username>@<hostname>'.    The <hostname> is the name of the 
machine where your party is logged on, and the <username> is his/her login name on that machine.      
This address is not necessarily the same as a user’s email address!    See the talk addresses 
section for more details.



Configuring Local Usernames

The local usernames dialog is shown above.    For a description of local usernames, please click here.

To add a name:
Type the new name in the edit box, and then click the Add button.

To delete a name:
Select the address to be deleted, then click the Delete button.

To edit a name:
Select the name, and then edit the text in the edit box.    The Add button will change to read Update. 
Click Update and the name will be changed.

To change the ordering of names:
Click and drag the names into the order you prefer.    The topmost names will be the easiest to 
access from the talk dialog.

Auto-add:
WinTalk can automatically remember new “from” names you use in the talk dialog by adding them to
your local usernames - check this box to enable this feature.

Keeping the list in most-recently-used order:
The “move last used to top” checkbox causes the last local username you used as a “from” name 
to be moved to the top of the list, thus making it the default for the next talk.

Saving your changes:



Clicking the OK button will save all changes and dismiss the dialog.

Cancelling your changes:
Clicking Cancel will leave your local username configuration unchanged and dismiss the dialog.



Confguring the Hotlist

The hotlist dialog, which allows you to maintain a list of frequently called addresses, is shown above.    
The addresses in your hotlist will be easily available to you in the talk dialog.

To add an address:
Type the new address in the edit box, and then click the Add button. The address must be of the 
form “<username>@<hostname>“.

To delete an address:
Select the address to be deleted, then click the Delete button.

To edit an address:
Select the address, and then edit the text in the edit box.    The Add button will change to read 
Update.    Click Update and the address will be changed.

To change the ordering of addresses:
Click and drag the addresses into the order you prefer.    The topmost addresses will be the easiest 
to access from the talk dialog.

Auto-add:
WinTalk can automatically remember new addresses you use in the talk dialog by adding them to 
your hotlist - check this box to enable this feature.

Keeping the hotlist in most-recently-used order:
The “move last used to top” checkbox causes the last hotlist address you talked to be at the top of 
your list, and hence the default for your next talk.



Saving your changes:
Clicking the OK button will save all changes and dismiss the dialog.

Cancelling your changes:
Clicking Cancel will leave your hotlist configuration unchanged and dismiss the dialog.



Finger is a common TCP/IP utility program that finds out information about users, typically on multi-user 
machines.    There are several winsock finger clients available, which you should be able to find at the 
standard archive sites (sunsite.unc.edu, ftp.cica.indiana.edu, etc...).



Configuring the Window Style

To change the window style for all talks:
Select “Configure...” then “Window Style” from the WinTalk icon menu.

To change the window style of an active talk:
From the talk window, select “Configure” then “Window Style”.

Either of these methods will bring you to the window style dialog:

The panes to the left are a stylized view of what your talk window will look like.    You can play with the 
various options and see what they look like before deciding to commit any changes.

Window orientation:
To change the orientation of the windows (up/down or side/side), click the orientation button.

Talk font:
To change the font, click the font button and choose a font from the dialog.

Text colors:
To change the colors, click the edit colors button.    The dialog will expand to include a color palette. 
You'll also note that one of the talk panes wll be highlighted with a dotted line.    Clicking a talk pane 
will cause it to be the active one.    Clicking a color with the left mouse button will change the text 
color of the active pane, and clicking a color with the right mouse button will change the background 
color of the active pane.    Clicking the edit colors button again will collapse the dialog to its original 
size.

Keeping your changes:
If you are satisfied with your changes, you may click either the apply or the set defaults buttons.    
The apply button is only enabled if you brought up the dialog from an active talk - it will apply the 
new window style to that talk session, but any future talks will be unaffected.    Clicking the set 
defaults button will cause WinTalk to remember the new window style, and use it for all future talks.

Cancelling:
Clicking cancel, as per usual, will dismiss the dialog and trash your changes.



Using command-line arguments

How to use command-line arguments:
Selecting “File”, then “Run”, from the Program Manager will bring up a dialog with a “command line”
field.    You may enter WinTalk's pathname here, followed by either of the argument styles described 
below.    Alternately, you may associate a Program Manager icon with a particular set of arguments - 
to do this, select “File”, then “New”, from the Program Manager menu, select “Program Item”, enter 
the pathname of WinTalk followed by the desired options in the “Command Line” field.

Specifying the location of the WINTALK.INI file:
Format:

/i <pathname>

Description:
If you are sharing a single copy of WinTalk with other users on a file server, you probably want to 
maintain a local configuration file for each user.    The /i option allows you to accomplish this by 
specifying the pathname of the wintalk.ini file.

Example:
To specify a wintalk.ini file which lives in D:\USERS\FRED\WINTALK.INI, you would start WinTalk 
with a command line of:

/i D:\USERS\FRED\WINTALK.INI

Automatically talking a user on startup:
Format:

[/f <name>] <user>@<host> [<TTY>]

Description:
The <name> argument is optional, and specifies the “from” name of the call.    The user will see an 
announcement of a talk request from “<name>@<your-pc's-address>“.    The <user>@<host> 
argument tells WinTalk who to talk to, and the optional <TTY> specifies a particular terminal at which 
to call them.
 
You may create program manager icons to talk to specific people this way, or you might activate 
WinTalk from another program (a WWW browser, for instance) and pass it arguments.

Example:    
To automatically talk to “reed_richards@FF.ORG” with a from name of “spidey”, you'd use the 
following command line:

/f spidey reed_richards@ff.org

Assuming your PC is “pc.cyberspace.org”, Reed would see “Talk request from : 
spidey@pc.cyberspace.org” on his terminal.

Doing both:
You may combine the arguments above to specify a user to talk with and a non-standard ini file 
location.





The Disclaimer

BY ACCEPTING THIS SOFTWARE PRODUCT THE USER AGREES TO BE BOUND BY THE TERMS
OF THIS DISCLAIMER.    DO NOT PROCEED FURTHER WITH THE USE OR INSTALLATION OF 
THIS SOFTWARE PRODUCT WITHOUT FIRST READING AND UNDERSTANDING THE TERMS 
STATED BELOW.

The version of WinTalk (Version 1.26), Copyright (c) 1994-1996 by ELF Communications, Inc., provided 
herewith, is hereby distributed as so-called “freeware”.

By that term, ELF Communications, Inc., intends to distribute this software product without the 
reservation of any proprietary or other economic rights.    Each user may, in turn, distribute this software 
product to other users without obtaining the permission of ELF Communications, Inc,; provided only that 
(i) no user may distribute the software product, either by itself or in conjuction with any other product or 
device, in exchange, either directly or indirectly, for profit, the intention of profit or any other economic 
considerations, without the express written permission of ELF Communications, Inc., which said 
permission may be conditioned, withheld or delayed at its sole discretion, (ii) each copy so distributed by
a users includes this “WINTALK.HLP” file and (iii) the copy so distributed has not been altered, modified,
impaired or damaged. Any user who distributes this software product in violation of these specifically 
reserved conditions shall be liable for any and all claims, losses, damages and liabilities resulting 
therefrom.

ELF COMMUNICATIONS, INC., HEREBY DISCLAIMS ANY AND ALL REPRESENTATIONS AND 
WARRANTIES OF ANY KIND, EXPRESS OF IMPLIED, MADE WITH RESPECT THERETO, 
INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE.



The Talk Window

The talk window is where it all actually happens.    It looks something like this:

The status bar:
When the window appears, various messages will appear in the status bar.    These (generally self-
explanatory) messages indicate the progress of the talk connection.

Trying again on failure:
If your party is not logged on, refusing messages, or times out, you may retry the talk request by 
selecting “Try again” from the “File” menu, or hitting ^T.

Talking:
One pane (the top or left one) is where you type, and the other is where you see what your partner is
typing.    Each character you type in your pane will be instantly echoed to your partner's terminal, and
vice versa.

Scrollback and cut/paste:
You may scroll back through either pane to see earlier parts of the conversation, and copy text from 
either pane to the clipboard with the Edit->Copy command (or ^C).    You may paste (^V) text from 
the clipboard to your edit pane, and it will be automatically sent across the net to your partner.

Configuration options in a talk:
The “Configure” menu offers two in-conversation configuration options - window style changes the 
look of the talk window, and auto-wrap adjusts the wrap column so WinTalk can format your text 
nicely on the remote machine.

Ending your talk:
To close a connection, you may either close the window, select “File->Exit”, or hit ^Q.    The first two 
options will destroy the window, while ^Q will leave the window visible so you may review the text of 
the conversation.



Using the Ring Dialog

The ring dialog looks like this:

Clicking talk will open a connection to the caller, and a new talk window will appear.

Clicking refuse will dismiss the dialog, and the caller will see either a “refusing messages” or a “not 
logged in” message (see general configuration for information on configuring this option).

Clicking ignore will dismiss the dialog, and it will appear to the caller that your terminal is continuing to 
ring until they decide to hang up.



Using the Answer Dialog

If you've disabled the pop-up dialog notification for rings, you may deal with incoming talk requests by 
listening for the WinTalk “ring” sound, and then selecting “Answer” from the icon menu.

A dialog will appear listing all currently active incoming “rings”.    To handle each one, simply select it by 
clicking or hitting the arrow keys, and then press one of the buttons below the listbox:

Clicking talk will open a connection to the caller, and a new talk window will appear.

Clicking refuse will dismiss the dialog, and the caller will see either a “refusing messages” or a “not 
logged in” message (see general configuration for information on configuring this option).

Clicking ignore will dismiss the dialog, and it will appear to the caller that your terminal is continuing to 
ring until they decide to hang up.



Just as Windows edit controls will word-wrap your text for you, the autowrap feature allows WinTalk to 
do the same for your remote partner.    This is very handy when talking to Unix users, and makes your 
text look a lot nicer for them.    Most Unix terminals are 80 columns in width, so WinTalk defaults to a 75-
column wrap.    If you are talking to someone with a wider or narrower screen, you should set the auto-
wrap appropriately.    Auto-wrap automatically disables if you're talking with another WinTalk user.



WinTalk Pro

WinTalk Pro
There is also a commercial version of this program available from ELF Communications.    WinTalk Pro 
provides the following advantages over the freeware WinTalk:

1. Call Answering, which acts as a TALK answering machine!    You can configure an outgoing 
message, and optionally accept incoming messages.    The icon's eyes flash to indicate new 
messages, and you can talk anyone who's left a message with the click of a button.

2. Call Screening, which allows you to mark certain users on your hotlist as VIPs.    In screening mode,
VIP users ring through to you, while everyone else gets either a refusal, an indication that you aren't 
logged on, or your answering machine.

3. Your very own WinTalk floppy in the mail (should you desire it - WinTalk pro will also be available 
across the net)

4. Free copies of all maintenance releases until the release of v2.0
5. A copy of WinTalk Pro version 2.0 when it's released for just $5
6. The warm fuzzy feeling of supporting the development of software you use and enjoy!

Ordering Information
This information is current as of March 20, 1996.    If you have a web browser, I would highly recommend
looking at http://www.elf.com/elf/wintalk/pro.html to make sure you have the most current address / 
prices / ordering info.

At this time, the only way to pay for WinTalk Pro is by mailing ELF a check, money order, or cash 
(standard disclaimer about being careful when sending cash through the mails).

WinTalk Pro can be picked up across the net or mailed to you on a 3.5" floppy disk.    If you opt for 
network pickup, the price is US $20.    If you'd like a floppy, the price is US $25.    The extra $5 is for 
shipping costs, a trip to the post office, and to discourage wasting environmental resources on floppies.   
If you're using WinTalk, you're very likely connected to the net, which is the greatest software distribution
system ever.    Why not use it?

You can mail your payment to ELF at:

ELF Communications
27 Perry Street
Somerville, MA 02143

Please remember to include:
- Your name
- Your address
- Your email address, so I can send you downloading instructions
- A check for $20 (net pickup) or $25 (3.5 floppy)

If you have any questions about the pro version, please check out the web page or email to 
"wintalk@elf.com".



The TTY field may contain an option argument to specify exactly which terminal on a multi-user host you
would like to ring your party at.    This information is generally gleaned from the output of the finger 
program - if a user is logged in more than once, you generally wish to talk them at the terminal which 
has been idle for the shortest amount of time.    WinTalk will remember (for the course of a WinTalk 
session) which terminals you've used to talk to users on your hotlist, and present you with those 
terminals as options in the TTY listbox.



Talk vs. Email addressing

One of the most common problems users have with WinTalk is getting a “no remote talk daemon”, 
“can’t resolve hostname”, or “your party is not logged on” message when they know the other party is 
waiting for their call.    One of the most common reasons for this problem is talking a user at an incorrect 
address.    Here’s how this can happen:

When you send electronic mail to someone on the internet, you need to get that mail to a mail server, a 
machine running the correct email protocols to store or deliver your message.    Typically, mail servers 
are Unix machines.    Now, in the old days, back before SLIP and the PC revolution, you had to actually 
log on to a unix machine to read your mail, or use FTP, or do any of the other network-intensive tasks, 
like using talk.    This meant that, in general, a user’s talk address was the same as their email address.

Nowadays, this just isn’t necessarily true.    Many users now connect their PC’s directly to the internet 
with dialup SLIP software or an ethernet connection, and never actually log on to a Unix shell account.    
This means, among other things, that you cannot talk them at their email addresses.    The hostname 
portion of the email address is the mail server, typically a large machine which stores email, and which 
may not even be running a talk daemon!

So, if you’re trying to talk to someone running a talk program such as WinTalk on their PC, you need to 
make sure the hostname portion of the address is the hostname of the user’s PC, and not their email 
server.

Here’s an example.    Jaqueline uses frednet.com as her network provider.    Fred (the friendly sysop at 
frednet) runs an email server on his unix machine, so Jaqueline’s email address is 
jaq@frednet.com.      Now, when Jaqueline connects her PC to the net, Fred has assigned her the 
hostname jaqueline.frednet.com.    So, although you send her email at jaq@frednet.com, you 
have to talk her at jaq@jaqueline.frednet.com.    Since PC’s don’t generally have “logins” per se, 
WinTalk supports local usernames.

Please make sure you’re talking a user at the right address before you assume there’s a problem with 
the local or remote talk system.    More information on these issues can be found in the WinTalk FAQ, 
which is accessible via the web (http://www.elf.com/elf/wintalk/wintalk-faq.html) or ftp (ftp.elf.com, 
/pub/wintalk/wintalk-faq.txt).



You can cause WinTalk to be an "icon tray" application by adding the following line to your wintalk.ini 
file:
tray_only = yes
With this option enabled, WinTalk will appear only as a small icon in the taskbar tray area, saving the 
space of a full taskbar pane.    This feature is provided as an option for now because there's still a small 
bug with it - after you use WinTalk's menu, the tooltips for the tray icons will stop working until you click 
on any other tray icon.    I consider this a small bug, and since so many people have asked for this 
feature, I'm going to include it now.    Look for a maintenance release that fixes this problem in a while.



Using WinTalk as a web helper application

It is now possible to set up links on the World-Wide Web which will automatically bring up WinTalk and 
initiate a talk to a given user.    The procedure for doing this is outlined below:

Setting things up
The Server Side
The web server where the links live must be configured to recognize files with the extension ".wtk" and 
transmit them as MIME type "application/x-wintalk".    See the docs for your server to find out 
how to do this exactly.    For example, if you're running the CERN httpd, you add the following line to 
your httpd configuration file:
AddType .wtk application/x-wintalk      8bit    1.0

The Client Side
You must configure WinTalk as a helper application for MIME type "application/x-wintalk", file 
extension ".wtk".    In Netscape, this is in the Options->General Preferences dialog.    Select the 
"Helpers" tab, and then click "Create New Type".    Enter "application" for MIME type, and "x-wintalk" for 
subtype.    A new line will then appear in the file type listbox.    Now enter "wtk" in the File Extensions 
box, click "Launch Application", and enter the location of the WinTalk 1.25 executable on your system by 
typing it in or selecting "Browse" and finding it by browsing your hard drive.

WinTalk links
Setting up a link involves creating a very small file (on your web server) with the extension .wtk, and 
then putting a link to that file in your web document.

The .wtk file
The .wtk file is just one line, the address of the person you'd like the link to talk to.    So for instance, the 
contents of the file john.wtk on my web server might be:
john@the.net.com

The anchor
Once you have a .wtk file, simply add a link to it in your HTML document as follows:

This is a link that will <a href="john.wtk">talk to john</a> with <a 
href="http://www.elf.com/elf/wintalk.html">WinTalk</a>!

If your server and client are configured correctly, you should then be able to click on the words "talk to 
john" in the example above, and WinTalk will attempt to talk to "john@the.net.com".




